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Abstract: The endoscopic transsphenoidal approach (ETA) is a novel approach used by
neurosurgeons and otolaryngologists to treat pituitary adenoma, and it has a long learning
curve. Training is mostly performed using cadaver heads, but their low availability and
cost can limit their use. ETA training models can be used to overcome these limitations.
In this panorama, additive manufacturing (AM) technologies represent a more flexible
and cost-effective solution to fabricate custom-made training models. Their development
involves computed tomography (CT) segmentation, STL file elaboration, direct 3D printing,
and rapid parts tooling. This work presents and discusses the entire procedure applied to
a modular ETA training model. The procedure starts with selecting the material and AM
processes based on a literature review. Accordingly, the parts of the model were designed,
3D printed, or rapid cast. In particular, fused filament fabrication (FFF) was adopted for
those tissues whose materials could be directly printed (bones and cartilage), while the
rapid casting of silicone was adopted for soft tissues (skin and mucosa) together with FFF
to fabricate mold patterns and cores. After fabrication and assembly, the model was finally
tested by an experienced neurosurgeon who provided feedback. Moreover, the cost and
time of the prototype fabrication were assessed. Results validated the proposed solution
from both the surgical and commercial points of view. Moreover, general procedures for
designing and rapidly fabricating ETA models were generalized to make them exploitable
to more general case studies.

Keywords: additive manufacturing; rapid tooling; rapid casting; transsphenoidal surgery;
training model

1. Introduction
The pituitary gland is located below the hypothalamus in the sella turcica, a saddle-

shaped prominence on the back of the sphenoid bone. The sellar region is also the location
of the arachnoid membrane, the optic chiasm, and the internal carotid artery. A tumor
can grow on the pituitary gland, resulting in an alteration to the functioning of the gland.
Such a tumor is called pituitary adenoma or Pituitary Neuro-Endocrine Tumor (PA or
PitNET), and its optimal surgical treatment requires years of experience in the field [1–4].
Nowadays, one novel surgical technique to treat PAs is the endoscopic transsphenoidal
approach (ETA). ETA surgery consists of removing the PA by entering through the nostril

J. Manuf. Mater. Process. 2025, 9, 63 https://doi.org/10.3390/jmmp9020063

https://doi.org/10.3390/jmmp9020063
https://doi.org/10.3390/jmmp9020063
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://www.mdpi.com/journal/jmmp
https://www.mdpi.com
https://orcid.org/0000-0002-7438-0734
https://orcid.org/0000-0001-6497-5876
https://doi.org/10.3390/jmmp9020063
https://www.mdpi.com/article/10.3390/jmmp9020063?type=check_update&version=2


J. Manuf. Mater. Process. 2025, 9, 63 2 of 27

cavities with the instruments. Then, the sphenoid sinus is opened to expose and remove
the PA. The surgery is usually performed by both neurosurgeons and otolaryngologists and
requires experience, high skills, and great hand–eye coordination. Nowadays, surgeons, to
overcome the significant learning curve of ETA, can acquire experience in the field or by
training in the anatomical labs with cadaver heads [2,3], which is still the gold standard
in terms of training and advanced skills acquisition [1]. However, training with cadaver
heads is not always an accessible solution due to their low availability and their high costs.
Moreover, clinical anatomy or disease depends on the donor, and the surgeon cannot decide
a priori which case to train on.

With the recent improvements and accessibility of additive manufacturing (AM)
technologies, the application of AM in the field of medicine has gradually developed
over time [5]. This is leading to the development of new alternatives to classical surgical
training allowing the fabrication of realistic anatomical models [1,5]. The main reason is
the possibility of obtaining complex anatomical geometries at relatively low costs [6,7].

For these reasons, the present research focuses on the development of a training model
for ETA, from the CT of a patient to the fabrication of the model. In particular, the paper
presents, discusses, and validates a comprehensive procedure developed for its design and
rapid fabrication.

This research starts with literature and market reviews to outline the current solutions
and products, evaluating which materials are used to emulate the tissues of interest, how
they are processed, and the prices of commercial products. Based on the results, a flexible
and cost-effective solution that guarantees the replication of the tissue behaviors (suitable
for bones, cartilage, mucosa, and skin) and additive manufacturability is outlined. Then,
the paper proposes the procedure adopted to design the ETA model by isolating anatomical
details, coupling parts, and designing molds and cores. Finally, it describes the direct
manufacturing of the parts using fused filament fabrication (FFF) of polylactic acid (PLA)
and thermoplastic polyurethane (TPU) and, in particular, the silicone rapid casting process.

The fabricated ETA model was then validated. In particular, a team of surgeons
furnished their positive feedback together with suggestions for enhancing the product.
Moreover, cost and time estimations demonstrated that the product is market-consistent
and can be competitive.

Overall, the article contains complete and detailed information collected and processed
to be exploitable in other applications, regardless of the case study presented. In particular,
research on materials and technologies reports a long list of possible alternatives that
can be explored or implemented where required. Furthermore, the design and rapid
casting procedures for fabricating training models are generalized, and procedural details
are provided to make them exploitable for other case studies. Finally, market prospects
represent a reference for verifying and allocating similar products.

2. Selection of Materials and Processes
Research on materials, production technologies, and commercial products was per-

formed considering the solutions present in the literature and on the market. The tissues
of interest for the development of the ETA training model are the bone (i.e., the sphenoid
bone), cartilage (i.e., nasal septum), skin (i.e., the nose), the mucosa (turbinates), the dura
mater, the arachnoid membrane, and the pituitary tumor. Results are reported in Tables 1–3.
Table 1 reports the information focused on the replication of the tissue’s general behaviors,
independently from the application. Table 2 collects the results correlated to the fabrication
of ETA models, including their price. Finally, Table 3 reports the prices of other commercial
products for which the manufacturing details were not declared.
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The information collected on materials and additive manufacturing processes
(Tables 1 and 2) was used to design the manufacturing process of the modules of the ETA
model. In particular, the choice was made preferring those solutions characterized by the
capability of emulating the mechanical and haptic properties of biological tissues involved,
a higher flexibility in terms of materials, and a lower cost. Accordingly, the FFF process
was selected for the fabrication of rigid parts and tools. In particular, the nasal septum was
3D printed in TPU, whose lower flexural modulus compared to PLA is more suitable for
imitating cartilaginous tissues [8], and PLA was selected to replicate bone tissues [9–13].
Moreover, the mechanical properties of the nose and turbinate, respectively made of skin
and mucosa, are well replicated by silicone [14–19]. Given the complexity of the 3D printing
of silicone [20], rapid tooling was chosen to fabricate silicone modules [7,21]. Furthermore,
silicone rapid casting allows one to choose amongst a wide range of material hardness
for replicating soft tissues compared to commercial feedstock materials of selective laser
sintering (SLS) [22] or PolyJet (PJ) [23].

Table 1. The materials and production technologies used to reproduce the different modules of
biological tissues.

Tissue Material Production
Technology References

Bone

PLA FFF/FDM [9–13]

PA with glass beads SLS [24–26]

CAH BJ [27,28]

3DPIC BJ and Mold Casting [29]

Cartilage TPU FFF [8]

Skin

Silicone Mold Casting [14,16,17]

Agar - [14]

Gelatin - [14]

Polyurethane - [14,30]

PVA - [14]

Mucosa Silicone Mold Casting [15]

Dura Mater
Silicone Coating [24,26,31,32]

Polyurethane Coating [28]

Arachnoid Polymeric film - [33,34]

Tumor

Resin a - [2,35]

Boiled Egg - [22,23,36]

Agar Mold Casting [37]
Abbreviation: FFF = fused filament fabrication, FDM = fused deposition modeling, SLA = stereolithography,
SLS = selective laser sintering, BJ = binder jetting, PLA = polylactic acid, CAH = cyanoacrylate with hydroquinone,
3DPIC = 3D polymer-infiltrated composite, ST-504, PVA = polyvinyl alcohol, TPU = thermoplastic polyurethane.
a = Stratathane ST-504 Vari-Lok injection resin.



J. Manuf. Mater. Process. 2025, 9, 63 4 of 27

Table 2. Materials, production technologies, 3D printers, and the price of commercial ETA models [1].

Tissue/Anatomy Material Technology 3D Printer Costs Ref.

Head n/d PJ Connex 500 n/a [38]

Rigid
Components d Duraform PA12 SLS

DTM
Sinterstation

2500 plus 2500 EUR [22]

Flexible
Components d Duraform Flex SLS EOS P760

Sellar region
Thermosetting resin
impregnated with

polyester resin
MJ ProJet® 160

200 USD a [18]
Brain, Dura Mater

and Pituitary Tumor Silicone Rubber RC -

Nose Silicone Rubber
ProtoFlex 150-05 RC -

Head n/d PJ Objet750 Connex 500 USD b [39]

Head
VeroCyan,

VeroMajenta
and VeroYellow

PJ Connex3
Objet350 n/a [34]

Skin, turbinate, ICA
and optic chiasm Soft material d

PJ J750 n/a [23]
Bones Hard material d

Head n/d PJ Objet J750
Connex n/a [40]

Skull PLA FFF Ultimaker2
n/a [15]Surgical Area d Plaster BJ ProJet 660 Pro

Face, ICA, pituitary g
land and optic nerves Silicone RC -

Head VisiJet PXL powder CJP - 63 USD a [41]

Internal nasal
anatomy n/d SLA Form 2

80 USD c [19]
Soft tissues Silicone RC -

Abbreviations: BJ = binder jetting, CJP = ColorJet printing process, FFF = fused filament fabrication, ICA = internal
carotid artery, MJ = material jetting, PJ = PolyJet, RC = rapid casting, SLS = selective laser sintering, SLA = stere-
olithography, n/d = not declared, n/a = not available. a = cost per model, b = production cost, c = material cost,
d = not specified.

Table 3. Commercially available models and prices [1].

Developer Simulated Surgical Task Price Ref.

Pro Delphus (Olinda, PE, Brazil) Neurosurgical Training 3.798 ÷ 1.630 USD [24–44]
JMC (Chuo-ku, Tokyo, Japan) Neurosurgical Training n/a [45–49]

Phacon GmbH (Leipzig, Germany) Neurosurgical Training 1.870 ÷ 11.070 EUR [50–55]
UpSurgeOn S.r.l. (Assago, MI, Italy) Transsphenoidal Approach 600 ÷ 700 EUR [56–59]

Abbreviations: n/a = not available.

2.1. Bone—Sphenoid Bone and Ethmoid Bone

To reproduce the sphenoid bone, polylactic acid (PLA) was chosen. Parts were fabri-
cated by FFF technology on the Ultimaker 3 extended (Ultimaker, Utrecht, The Netherlands),
using the Pearl-White PLA by Ultimaker, whose main properties, taken from its technical
datasheet [60], are reported in Table 4.
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2.2. Cartilage—Nasal Septum

The lower bending resistance of thermoplastic polyurethane (TPU) makes it more
suitable for reproducing the flexibility of cartilaginous tissues, as reported in the litera-
ture [8]. TPU has a lower flexural modulus and a higher resistance to strain compared to
PLA, making TPU more suitable than PLA for this application. Similarly, the nasal septum
was fabricated using FFF technology on the Ultimaker 3 extended using the TPU 95A by
Ultimaker, whose main properties, taken from its datasheet [61], are reported in Table 4.

2.3. Skin and Mucosa—Nose and Turbinates

Silicone was chosen to replicate both the nose module and the turbinates module.
In particular, it was carried out using the Dragon Skin™ 30 (Smooth-O Inc., Macungie,
PA, USA), whose main properties are reported in Table 4 using information from its
datasheet [62]. In particular, silicone modules were produced with the traditional mold
casting technology, since the additive manufacturing process of two-component silicone
is not mature yet [20]. The skin and mucosa silicone molds were fabricated using PLA
print cores of the parts into which the silicone was poured. The fabrication of silicone
components is described in the following sections.

Table 4. Mechanical properties of Pearl-White PLA and TPU 95A. XY, YZ, and Z refer to the orientation
of the specimen tested; XY is the printing plate, while Z is the printing direction. Data are taken from
material datasheets [60–62]. NB = no break (>10%).

Mechanical Property Material
Value (Orientation)

(XY—Flat) (YZ—Side) (Z—Up)

Flexural modulus (MPa)
PLA

3019 ± 87 2894 ± 53 2740 ± 47
Flexural strain at break (%) 4.8 ± 0.2 NB 1.9 ± 0.2
Hardness (Shore D scale) 84

Flexural modulus (MPa)
TPU 95A

62.6 ± 1.7 55.1 ± 2.4 62.6 ± 2.0
Flexural strain at break (%) NB NB NB
Hardness (Shore D scale) 48

Hardness (Shore A scale)
Silicone

30
Pot life 45 min

Curing time 16 h

2.4. Dura Mater, Arachnoid, and Tumor

The arachnoid membrane was reproduced with the polymeric food film as found in the
literature [33,34], which was considered a good representation in our previous work [63].
The pituitary tumor, as it was found in our systematic review [1], was reproduced following
an interesting training model, called “Egghead” [22], where the sellar region and its content
were reproduced using an egg [22,23,36,64–66], in particular, both the boiled yolk [22] and
the boiled albumen [23,64] were used as a reproduction of the tumor. Together with the
experienced surgeon, we evaluated that the boiled albumen is a good approximation and
low-cost solution to mimic the mechanical properties of the pituitary tumor [67,68].

The materials suitable for the ETA model and the AM fabrication processes were
accordingly selected to fabricate the parts or their tools (pattern and cores) in case of a rapid
casting process. Table 5 reports an overview of the selected materials and AM processes
together with the tissues to be manufactured and the hierarchy of the model (groups and
modules) that will be further described.
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Table 5. Module of the training model, the fabrication technologies, and the materials used for
their production.

Group Module Tissue Process
AM RC

Disp.
Material Technology Material

Face
Face Skin RC PLA FFF

(Pattern) Silicone no

Ethmoid bone Cortical Bone AM PLA FFF - no
Nostril (core) Cavity RC PLA FFF (Core) - no

Nose Nasal septum Cartilage AM TPU 95A FFF - yes

Nasal cavity Turbinates Mucosa RC PLA FFF
(Pattern) Silicone yes

Frame Non-anatomical AM PLA FFF - no

Skull base

Sphenoid bone Cortical Bone AM PLA FFF - yes
Ethmoid bone Cortical Bone AM PLA FFF - no

Arachnoid Arachnoid
membrane - Polymeric

food film - - yes

Tumor Pituitary
adenoma - Egg white - - yes

Abbreviations: AM = additive manufacturing, RC = rapid casting, Disp. = disposable.

3. Design of the Model
The flowchart of the design process is reported in Figure 1 with the main steps of the

procedure and the hierarchy of the parts of the ETA model. The anatomy was obtained from
a CT scan using a 1 × 1 frame with contiguous slices at 1.5 mm and a gantry angle of 0◦.
The scan window was 225 mm in diameter and used a pixel size of 0.44 mm. The CT scan
was segmented using Materialize Mimics© software v22.0 and converted to STL format
files. Then, Meshmixer (Autodesk Inc., San Francisco, CA, USA) was used to edit the STL
file. In particular, the initial editing consists of general cleaning of the mesh by eliminating
the errors on the STL file (mostly removal of isolated parts and repairing holes and open
edges in the mesh, using the Inspector tool). Then, the area of interest is cropped (Figure 2),
initially divided into sub-parts (Figure 3) that will be used to then design the three main
groups (Figure 4): Face (from Figure 2a with the ethmoid bone in Figure 3a), Nasal Cavity
(from Figure 3b), and Skull Base (from the sphenoid bone in Figure 3a). Each part was
isolated using the Plane Cut tool and locally fixed using the Inspector and Sculp tools to
remove any not useful cavities inside the bones or to fix small mesh errors. Finally, the
modules were edited as described below until the final ETA model was obtained (Figure 4).

3.1. The Face Group

The Face group (Figure 4) consists of the face (Figure 2a) and a section of the ethmoid
bone (Figure 3a). Nostril cavities are included to allow access for surgical instruments in
the training model. The face is made by rapid casting using the ethmoid bone and nostril
cores 3D printed in PLA as mold inserts. In addition, the face, combined with the ethmoid
and the nostril cores, was designed to become a unique casting part, where the ethmoid is
embedded in silicone and the nostril cores are removed after the silicone self-cures to form
the silicone mold.
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3.1.1. Face

The face module was obtained from the head of the patient and required minor editing
steps compared to the other modules. The geometry was isolated (Plane Cut tool), and then
it was turned into a solid (Make Solid tool, Figure 5).
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3.1.2. Ethmoid Bone

The function of the ethmoid bone module (Figure 6) is to provide rigidity to the nose,
which is better described in the following section. It was obtained using the Plane Cut tool
from the skull base (Figure 3).
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Figure 6. Ethmoid bone module.

3.1.3. Nostrils and Cores

The ETA procedure starts with surgeons inserting instruments from the nose. There-
fore, reproducing the nostril cavities during the molding process is fundamental for obtain-
ing a fully functional training model. Accordingly, two removable casting cores together
with core prints were designed to reproduce the nostril cavities. Their geometry was ob-
tained as the complementary volume of the nostril cavities to be reproduced. In particular,
the edge of each cavity was manually selected using the Select tool (Figure 7a), and the
selection boundaries were smoothed using the Smooth Boundaries tool to enhance the mesh
(Figure 7b–d). Then, a new group was generated from the selected elements using the
Create FaceGroup tool. The mesh was duplicated, and the elements outside the nostrils were
deleted, isolating the surfaces of the nostril cavities. The obtained geometries are tubular
surfaces with open ends. Therefore, they were closed using the Auto Repair tool with the Flat
Fill option of the Inspector tool, under the Analysis menu (Figure 7e,f), which automatically
recognizes the open surfaces and fixes the errors found (in this case, it filled the open areas).
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These surfaces will become the external mesh of the cores (i.e., the complementary volume
of the cavities); therefore, their normals were inverted using the Flip Normals tool under
the Select menu (Figure 7g). Moreover, the use of the Flat Fill option allows you to obtain
a smooth end surface with a low curvature. Finally, to guarantee the correct positioning
of the cores in the mold, the two end surfaces of each core were selected (Select tool) and
extruded along the Normal direction (Extrude tool, under the Select menu) to obtain the
core prints (Figure 7h). Figure 7i shows the nostril cores with the core prints.
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Figure 7. The edge of each cavity is manually selected using the Select tool and the selection bound-
aries are smoothed using the Smooth Boundaries tool to enhance the mesh quality (a–d). Then, a new 
group was generated from the selected elements using the Create FaceGroup tool. The mesh is closed 
using the Inspector tool (e,f). The mesh normals are inverted using the Flip Normals tool, under the 
Select menu (g). Moreover, the use of the Flat Fill option allows you to obtain a smooth end surface 
with a low curvature. Finally, to guarantee the correct positioning of the cores in the mold, the two 
end surfaces of each core were selected (Select tool) and extruded along the Normal direction (Ex-
trude tool, under Select menu) to obtain the core prints (h). The final result: nostril cores with the 
core prints (i). 

After casting, the cores will be extracted from both the silicone and the ethmoid bone 
once the silicone used for the face model has been cured. Before pouring the face silicone, 
the nostrils are inserted into the ethmoid bone, as shown in Figure 8, and then they are 
inserted into the silicone mold. Moreover, there must be no interference between cores 
and ethmoid modules, especially in the core prints. In fact, the manual and automatic tools 
used to design them may introduce minor geometrical errors that do not necessarily meet 

Figure 7. The edge of each cavity is manually selected using the Select tool and the selection
boundaries are smoothed using the Smooth Boundaries tool to enhance the mesh quality (a–d). Then,
a new group was generated from the selected elements using the Create FaceGroup tool. The mesh
is closed using the Inspector tool (e,f). The mesh normals are inverted using the Flip Normals tool,
under the Select menu (g). Moreover, the use of the Flat Fill option allows you to obtain a smooth end
surface with a low curvature. Finally, to guarantee the correct positioning of the cores in the mold,
the two end surfaces of each core were selected (Select tool) and extruded along the Normal direction
(Extrude tool, under Select menu) to obtain the core prints (h). The final result: nostril cores with the
core prints (i).
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After casting, the cores will be extracted from both the silicone and the ethmoid bone
once the silicone used for the face model has been cured. Before pouring the face silicone,
the nostrils are inserted into the ethmoid bone, as shown in Figure 8, and then they are
inserted into the silicone mold. Moreover, there must be no interference between cores and
ethmoid modules, especially in the core prints. In fact, the manual and automatic tools
used to design them may introduce minor geometrical errors that do not necessarily meet
the anatomy of the patient. Accordingly, the presence of geometrical interferences can be
verified by overlapping the ethmoid bone module with the two nostrils module as shown
in Figure 9a. The overlapping volume was removed from the ethmoid bone module using
the Boolean Difference tool, under the Edit menu, which is clear by comparing the ethmoid
bone before (Figure 9b) and after (Figure 9c) the Boolean difference. Figure 9d shows the
nostrils inserted into the ethmoid bone with no overlapping volume.
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Figure 8. Ethmoid bone with nostril cores fitted within.

Once the face, cores, and ethmoid bone are designed, the pattern required to prepare
the silicone molds can be designed (Figure 10). In particular, the pattern is obtained by the
union of face and core modules. This was achieved by joining the meshes of the modules
using the Combine tool and then transforming them into a single part using the Make Solid
tool, which is the final geometry of the pattern. Additionally, two holes were added to the
back of the nose module using the Boolean Difference tool with a cylinder (Figure 10b). The
holes will be used to connect, using two cylindrical plugs, the face module with the frame,
as shown in Figure 4.

3.2. The Nasal Cavity Group

The Nasal Cavity group represents the passage from the nostrils to the sphenoid bone
during the ETA procedure. Moreover, from the assembly point of view, it connects the
Face and Skull Base groups (Figure 3). Given the geometrical complexity of the nasal
cavity (Figure 11a,b), a frame was designed around the anatomical modules to improve the
“assemblability” of the model. Accordingly, several parallelepipeds were added and merged
into a single object (Combine tool, Figure 11c, followed by the Make Solid tool, Figure 11d).
The parallelepipeds formed closed holes around the original anatomy (Figure 11e) that
were removed (Select tool on surfaces to preserve, followed by Invert and Discard) thus
obtaining the final geometry of the entire nasal cavity (Figure 11f).



J. Manuf. Mater. Process. 2025, 9, 63 12 of 27

J. Manuf. Mater. Process. 2025, 9, x FOR PEER REVIEW 11 of 28 
 

 

the anatomy of the patient. Accordingly, the presence of geometrical interferences can be 
verified by overlapping the ethmoid bone module with the two nostrils module as shown 
in Figure 9a. The overlapping volume was removed from the ethmoid bone module using 
the Boolean Difference tool, under the Edit menu, which is clear by comparing the ethmoid 
bone before (Figure 9b) and after (Figure 9c) the Boolean difference. Figure 9d shows the 
nostrils inserted into the ethmoid bone with no overlapping volume. 

 

Figure 8. Ethmoid bone with nostril cores fitted within. 

(a)  (b)  

(c)  (d)  

Figure 9. The nostril core overlapped on the ethmoid bone (a,d). Before and after the Boolean dif-
ference and between the ethmoid bone and the nostril cores (b,c). The nostril cores are inserted in 
the ethmoid bone with no overlapping volume. 

Once the face, cores, and ethmoid bone are designed, the pattern required to prepare 
the silicone molds can be designed (Figure 10). In particular, the pattern is obtained by the 
union of face and core modules. This was achieved by joining the meshes of the modules 
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difference and between the ethmoid bone and the nostril cores (b,c). The nostril cores are inserted in
the ethmoid bone with no overlapping volume.
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Figure 11. The design procedure of the Nasal Cavity group. It is derived from the anatomy of (a) 
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3.2.1. Turbinates Module 
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ETA, which is typically not involved in the procedure. Therefore, for the sake of simplicity 
and manufacturability, only middle and inferior turbinates were included in this module, 
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Figure 11. The design procedure of the Nasal Cavity group. It is derived from the anatomy of (a) the
nasal septum and (b) turbinates. Then, (c) the frame was obtained with several parallelepipeds that
were merged and converted into a (d) solid geometry with (e) inner cavity defects. The (f) final
geometry of the entire Nasal Cavity group was obtained after removing the cavities.

Then, the entire nasal cavity was finally divided into three modules that form the Nasal
Cavity group: Turbinates (Figure 12), Septum (Figure 13), and Frame (Figure 14). In partic-
ular, the frame was the last module that was designed since it was obtained by subtracting
the other two modules from the entire nasal cavity with the Boolean Difference tool.

3.2.1. Turbinates Module

The Nasal Cavity group contains two sets of turbinates: upper, middle, and inferior,
respectively. Upper turbinates are the smallest and are located in the narrowest zone of
ETA, which is typically not involved in the procedure. Therefore, for the sake of simplicity
and manufacturability, only middle and inferior turbinates were included in this module,
while upper turbinates became part of the frame. Accordingly, both left and right turbinates
were isolated from the entire nasal cavity using the Plane Cut tool, Figure 12. In particular, a
prismatic shape was used at the interface with the frame (Figures 12 and 14b) to facilitate the
design, the fabrication, and the final assembly phases. In fact, simple geometries increase
the success rate when using the Boolean Difference tool, which was necessary in the design
of the Frame module.
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Figure 12. Turbinates modules. The middle and lower turbinates of (a) the left and (b) the right sides.

3.2.2. Nasal Septum Module

The nasal septum module was designed similarly to the turbinate modules. It was
isolated using the Plane Cut tool (Figure 13) obtaining two prismatic interfaces, upper and
lower. The module includes the part of the septum within the nasal cavities, while the
outer part remains in the external ethmoid bone of the Face group (Figure 6). This design
choice is because the internal posterior portion of the septum may be cut to make room
near the sphenoid sinus. On the contrary, the outer nasal septum is not cut. Accordingly,
the internal nasal septum must be a disposable part of the model. (Table 1). Moreover, the
Face group is a single-cast part, and it should allow the insertion of the septum within. This
would require a core that is more complicated to be designed and assembled/disassembled
with the ethmoid bone during the casting process. Moreover, the ethmoid bone has a
low thickness. Therefore, it is more difficult, if not unfeasible, to design an interlocking
geometry to mount and hold in place the septum. Given these considerations, the adoption
of a unique septum module that is shared by the Nasal Cavity and Face groups would be
an unnecessary complication.
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Figure 13. Nasal septum module. The square-section parts on the top and the bottom were designed
to facilitate the fabrication of the module and its insertion in the frame.

3.2.3. Frame Module

The frame is a box that holds turbinates and septum modules. Moreover, it connects
and holds in place the Nasal Cavity group with the Face and Skull Base groups. The frame
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was designed by subtracting the geometry of turbinates using the Boolean Difference tool
(Figure 12) and the septum modules (Figure 13) from the nasal cavity model (Figure 11e).
The dimensional geometrical accuracy of the FFF 3D printing process (approximately 0.2
to 0.5 mm) was considered in the design of the Frame module. In particular, to facilitate
the insertion of turbinates and nasal septum modules, a wider interlocking geometry was
designed. It was conducted by temporarily expanding the volume of the modules using
the Transform tool under the Edit menu to offset their surface. Accordingly, a larger volume
was removed, and a nominal allowance of 0.3 mm along each main direction was designed
in the interlocking zones. Finally, two holes were designed with the Boolean Difference tool
using two cylinders (as with the face module) on both sides of the frame to hold connecting
plugs (Figure 14a). Figure 14b shows the frame with the turbinates and nasal septum
modules inserted.
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Figure 14. The frame module. The frame (a) and the frame with the turbinates and nasal septum
module inserted (b).

3.3. Skull Base Group

The Skull Base group is composed of the sphenoid bone module and the arachnoid
membrane together with the system to emulate the cranial pressure of the cerebrospinal
fluid (CSF). The sphenoid bone is partially drilled during the surgical procedure to expose
the pituitary tumor. Therefore, the sphenoid was subdivided into two parts, one disposable
(upper sphenoid bone) and one reusable (lower sphenoid bone). Moreover, it was adapted
to be mounted with screws. The rest, i.e., the arachnoid and the system containing the CSF,
is part of further research focused on the implementation of sensors on the ETA model to
provide real-time feedback during simulations. Its main characteristics are described below,
and more details are reported in our previous work [63].

3.3.1. Sphenoid Bone

The sphenoid bone (Figure 3a) was cut into two halves using the Plane Cut tool, namely,
the upper and lower sphenoid bone. The upper half (Figure 15a) contains the sella turcica
and is the disposable part since it is drilled during the ETA simulation. The lower half
(Figure 15b) was kept as a support of the upper sphenoid bone. Moreover, two flanges
were added to each half using the Boolean Union tool for the assembly with the frame
(Figures 4 and 15c).
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Figure 15. Sphenoid bone module. (a) Upper sphenoid bone with the sella turcica and (b) lower
sphenoid bone. (a) The two modules are coupled (c). Each half is equipped with two flanges to
mount them on the frame module.

3.3.2. Arachnoid and Cranial Pressure

The addition of the arachnoid membrane is in development (Figure 16). Based on
our previous studies, we decided to implement a sensor-based non-anatomical module
to replicate two features that are not present in the current commercial products. The
first feature replicates the fall of the suprasellar arachnoid within the sellar region. This
is meant to train the surgeon to move the arachnoid membrane without breaking it and
subsequently causing a CSF leakage, which is one of the most common complications
related to surgery [4]. The second feature provides the surgeon with feedback on the force
applied to the membrane together with a measure of the CSF leak risk.
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Figure 16. The training model is equipped with the sensor-based tank, i.e., the system that simulates
the fall of the arachnoid within the sella turcica. (a) The CAD model, (b) the system mounted.

The module consists of a tank filled with distilled water to mimic the CSF. The system
is sealed on one side with a polymeric food film that reproduces the arachnoid, as suggested
by the literature [33,34]. In particular, intracranial pressure expands the arachnoid, which
falls inside the sella turcica thus filling the space left after tumor removal [1]. Furthermore,
the group is also equipped with a pressure sensor that can measure the force exerted by
surgeons when interacting with the arachnoid, whose preliminary design and tests are
reported in our previous study [63].
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4. Rapid Manufacturing
The model fabrication involved two prototyping processes, direct 3D printing (mod-

ules made of PLA and TPU, Figure 17) and rapid casting processes (silicone modules,
Figure 18).
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Figure 17. Direct 3D-printed modules: both the sphenoid bone module and the frame were 3D-printed
in Pearl-White PLA (a–c), while the nasal septum was 3D-printed in TPU (d).

The Ultimaker 3 extended printer equipped with an AA04 nozzle and 2.85 mm filament
was used to print modules in both Pearl-White PLA and TPU 95A and rigid tools in Pearl-
White PLA using a layer height of 0.1 mm. The infill density was 20% for PLA and 100%
for TPU. Pouring molds were made of the two components of the silicone Mold Star™ 15
SLOW (Smooth-On, Inc., Macungie, PA, USA), which has a Shore A hardness of 15 and a
pot life of 50 min. As already mentioned, casted parts were made of the two components of
the silicone Dragon Skin™ 30. To replicate skin color, the Light Flesh™ pigment (Smooth-
On, Inc., USA) was added to the Dragon Skin™ silicone. Furthermore, Ease Release™ 205
(Mann Release Technology, Macungie, PA, USA) was used as a release agent. The silicones
were degassed before pouring using a 90% vacuum chamber.

In rapid casting, cores and possible inserts are initially printed (Figure 18a). The
silicone used for the molds is prepared and degassed to remove the air entrapped during
pouring and mixing (Figure 18b). Then, the pattern with landmarks is temporarily fixed
on a clay substrate inside a box, and a releasing agent is applied on the surfaces that will
be in contact with the silicone (Figure 18c) during the pouring of the first half of the mold
(Figure 18d). Once the silicone is cured, the clay is removed. The half mold and pattern are
turned upside down, the lateral embankment and pattern of the pouring channel (made of
clay) are added, and, finally, the release agent is applied (Figure 18e). The second half mold
is then poured onto the first one (Figure 18f). After solidification, the pattern is removed,
the core and inserts are positioned, vents may be cut on the parting plane (if required), and
the releasing agent is applied (Figure 18g) to obtain the mold (Figure 18h). To cast the part,
silicone is prepared, degassed (Figure 18i), and poured (Figure 18j). If vents are used, the
mold should be tilted to facilitate air release. Once solidified, the core is removed from the
part, and the pouring channel is cut (Figure 18k) to obtain the final part (Figure 18l).
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Figure 19 shows some steps of the rapid casting of the Face module. Figure 19a shows
the pattern positioned on clay (Figure 19b, as shown in the illustration in Figure 18c) and
the resulting mold half (Figure 19c, as shown in the illustration in Figure 18d). Figure 19c
shows the mold with the nostril cores and ethmoid bone in place (as shown in Figure 18g).
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Figure 19d reports the cast face group with the embedded ethmoid bone insert (as shown in
Figure 18l). Similar results were achieved in the rapid casting of the turbinates (Figure 19e).
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Figure 20 shows a comparison between the CAD model of the training model
(Figure 20a) and the final training model (Figure 20b).
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5. Training Model Validation and Cost Assessment
The presented solution was assessed from two points of view, surgical and economical.

In particular, the model was directly tested by expert neurosurgeons who provided their
feedback, which was used for the first validation of the anatomy and materials. Moreover,
an estimation of the design and manufacturing costs was made.

5.1. Anatomy and Materials

A real surgical procedure was simulated using an endoscope, surgical curette, drill,
and forceps (Figure 21). Figure 21a shows the endoscopic view when passing through the
left side of the nasal cavity while the spatula is moving the turbinates to the side. Figure 21b
shows the dissection of the sphenoid bone to expose the sellar region and reach the pituitary
tumor. The dissected sphenoid bone disassembled after the test is reported in Figure 21c.
During the test, an attempt was made to drill, and scissors were used to cut the septum
(Figure 21d).

J. Manuf. Mater. Process. 2025, 9, x FOR PEER REVIEW 21 of 28 
 

 

(a)  (b)  

(c)  (d)  

Figure 21. Surgical tests to validate the training model. Endoscopic view of the nasal cavity (a) and 
upper sphenoid bone (b). Disposable parts after the surgical tests (c,d). 

5.2. Cost Estimation 

Design and manufacturing costs were estimated to evaluate the training model from 
an economic point of view and to compare it with the price of commercial ones. Costs 
were evaluated on the basis of materials and time required by the design and fabrication 
of the prototype (Table 6). In particular, the design of the parts required approximately 30 
h of direct CAD editing. Moreover, printing material and time were estimated using the 
slicing software. Furthermore, the purchasing cost of silicone was used in the costing pro-
cedure. The unit cost of the manual tasks was assumed to be 22.7 EUR/h based on the 
experience, and the unit costs of PLA and TPU were 0.048 EUR/g and 0.088 EUR/g based 
on the market prices, respectively. 

Results in Table 6 show that the overall cost of the prototype is approximately 1000 
EUR, and a lead time of 58 h is required. Most of the cost is due to CAD design time, which 
covers 68% of the final cost. The fabrication process of a replica (direct printing, rapid 
casting, and assembly) requires 28 h and costs 315 EUR. Considering that the cost of the 
prototype is slightly overestimated (patterns and cores are reusable) along with scale fac-
tors that reduce the lead time and cost of commercial products, the proposed solution is 
comparable, if not competitive, in cost compared to products on the market (Table 2, sili-
cone-casted models, 200 USD). 

Table 6. Design and manufacturing cost assessment of the training model. 

  Material Process time Cost 
  g EUR/g h EUR/h Material Time Sum 

CAD design STL editing - - 30 22.7  - 681 EUR 681 EUR 
Direct AM Part 3D printing—PLA 172 0.048 16.5 0.14 8.3 EUR 2.3 EUR 35 EUR 

 Part 3D printing—TPU 10 0.088 2.5 0.14 0.9 EUR 0.4 EUR  

Figure 21. Surgical tests to validate the training model. Endoscopic view of the nasal cavity (a) and
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The surgeon’s feedback indicated was as follows:

• The patient’s anatomy is accurately replicated, although the thickness of the sphenoid
bone and the nasal septum is slightly greater than expected.

• The response of PLA during the dissection of the sphenoid bone was good. The
removal with the forceps and drill is similar to reality, even though a “chewy” behavior
is present. Preliminary wetting of the model surfaces is preferable to prevent chip
sticking to the tip of the drill, which that may occasionally occur.

• The flexural strength of the TPU used for the nasal septum is comparable to real tissue.
Drilling was not applicable since the material mostly melts instead of chipping due to
high friction with the drilling tool. Scissor cutting was applicable, even though the
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excessive thickness of the septum required a high cutting force. This aspect can be
solved by lightening its thickness.

• The flexural strength of silicone is comparable to real tissue. Instead, its spring-back is
too high, causing the turbinates to move out of place instead of remaining fixed. To
address this issue, a plastic element, such as a metal wire, could be incorporated into
the silicone to achieve the desired functionality.

5.2. Cost Estimation

Design and manufacturing costs were estimated to evaluate the training model from
an economic point of view and to compare it with the price of commercial ones. Costs
were evaluated on the basis of materials and time required by the design and fabrication
of the prototype (Table 6). In particular, the design of the parts required approximately
30 h of direct CAD editing. Moreover, printing material and time were estimated using
the slicing software. Furthermore, the purchasing cost of silicone was used in the costing
procedure. The unit cost of the manual tasks was assumed to be 22.7 EUR/h based on the
experience, and the unit costs of PLA and TPU were 0.048 EUR/g and 0.088 EUR/g based
on the market prices, respectively.

Table 6. Design and manufacturing cost assessment of the training model.

Material Process time Cost

g EUR/g h EUR/h Material Time Sum

CAD
design STL editing - - 30 22.7 - 681 EUR 681 EUR

Direct AM Part 3D printing—PLA 172 0.048 16.5 0.14 8.3 EUR 2.3 EUR 35 EUR
Part 3D printing—TPU 10 0.088 2.5 0.14 0.9 EUR 0.4 EUR

Post-process - - 1 22.7 - 23 EUR

Casting Silicone casting (lump sum) 3 22.7 170 EUR 68 EUR 258 EUR
Silicone curing - - 4 - - -

Spare parts (lump sum) - - 20 EUR -

Assembly Assembly - - 1 22.7 - 23 EUR 23 EUR

Total 58 199 EUR 797 EUR 996 EUR

Results in Table 6 show that the overall cost of the prototype is approximately
1000 EUR, and a lead time of 58 h is required. Most of the cost is due to CAD design
time, which covers 68% of the final cost. The fabrication process of a replica (direct printing,
rapid casting, and assembly) requires 28 h and costs 315 EUR. Considering that the cost of
the prototype is slightly overestimated (patterns and cores are reusable) along with scale
factors that reduce the lead time and cost of commercial products, the proposed solution
is comparable, if not competitive, in cost compared to products on the market (Table 2,
silicone-casted models, 200 USD).

6. Discussion
During the development of the design and manufacturing procedures of the ETA

model, general aspects and comments were drawn.
The steps that lead to the prototype of the ETA model are summarized in Table 7 and

discussed as follows.
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Table 7. Summary and guidelines for the design and fabrication of the ETA prototype.

Step Details

Material
and Process

Selection

Tissue Process Design Notes

Bone Material: PLA
Process: FFF -

Soft tissue
(skin, mucosa)

Material: Silicone
Process: Rapid casting Flexible molds made of silicone

Cartilage
(Nasal Septum)

Material: TPU 95A
Process: FFF -

CAD design

Focus Editing procedure Tools sequence (Meshmixer)

Mesh fix

Preliminary operations
(isolated parts, close STL)

Analysis > Inspector
> Auto Repair

Local editing
(small artifacts removal) Sculp

Internal holes removal
Select * (on surfaces to preserve)

> Modify > Invert
> Discard

Part design
(modules and molds)

Crop Edit > Plane Cut

Interlocking
with allowances

Object Browser > Select object * (module)
Edit > Transform—Size X/Y/Z
Object Browser > Select objects * (modules
and other objects)
Boolean Difference

Core Design

Hole surface selection

Select * (on hole edge borders)
> Smooth Boundaries
> Modify > Create FaceGroup

Object Browser > Duplicate
Delete (the mesh outside the hole)

Volume from surface

Select * (on hole surface)
> Edit > Flip Normals

Analysis > Inspector
> Auto Repair (Flat Fill)

Print core design Select * (on core end surfaces)
> Edit > Extrude (Normal direction)

Removal of (eventual)
interferences

Object Browser > Select objects *
Edit > Boolean Difference

Objects Union
(Pattern)

Join
(module + core prints)

Object Browser > Select objects *
Edit > Combine
Object Browser > Select (new) object *
Edit > Make Solid

* Keep the elements or objects selected.

• Materials and process selection. Materials were chosen according to the literature to
enhance the mimicking of real tissue. Then, the more suitable additive manufacturing
processes were chosen. For bone and cartilage (made of PLA and TPU, respectively),
direct 3D printing was adopted, while rapid casting was selected for soft tissues (made
of silicone).

• CAD design. Four main design phases were identified: mesh fixing and the design of
modules, cores, and patterns (or, generally, object union). They are generalized and
reported together with the sequence of tools and commands in Figure 18 and Table 7.
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Furthermore, the following aspects of the procedure emerged during its implementation.

• Forward procedure. The steps of the procedure are straightforward, which reduces the
product development time and enhances the anatomical accuracy. In fact, editing
an STL file generally leads to geometrical approximations; therefore, fewer setbacks
accumulate less geometrical approximations in the part.

• CAD skills. The procedure strongly depends on human technical skills and experience,
especially in the CAD design and casting phases. In particular, the success in editing
STL mesh files deeply depends on both the quality of the mesh and the sequence
of commands. The mesh can be improved (smoothing, remeshing), but this may
significantly reduce the precision and accuracy of the part. Hence, the experience
of the designer is fundamental. Concerning the correct sequence of commands for
successful editing, the paper provides robust guidelines that help the design process.

• Manual silicone casting. The manual procedure requires additional lead time compared
to the direct fabrication of the parts. Conversely, their mechanical properties are limited
by the commercial feedstock materials. Moreover, printing rubber-like materials to
emulate soft tissues may require high-performance technologies (such as MultiJet
or PoliJet). SLA may represent an exception to this generalization, although it is
subject to the material limitations mentioned above. Conversely, manual silicone
casting provides a larger capability of replicating soft tissues’ mechanical properties.
Moreover, it is generally a low-cost solution compared to direct printing, as shown by
the price of commercial products (Table 2).

Overall, the following general comments can be outlined on the model developed.

• Validation. The proposed procedure led to an accurate replication of the surgical
operation. In particular, the overall anatomy, bone “drillability”, and the flexibility of
cartilage, mucosa, and skin are well simulated.

• Improvements. Some anatomical details should be improved (thickness of the sphenoid
bone and nasal septum). Moreover, a wetting system could reduce the risk of the PLA
melting during drilling and enhance the aesthetic result. Finally, the spring-back of
turbinates needs to be removed.

• Advantages of the model. The modular design, together with casting silicone, makes
the model highly customizable in anatomy and materials. Therefore, it is possible to
emulate a specific surgical case on the basis of the surgeon’s requests.

• Fabrication time and cost. Most of the development costs of the model were given by
the CAD design phase. A replica of the prototype approximately costs 300 EUR and
can be produced in less than 2 working days, values that may be lower in a mature
product. These estimations confirm the economic soundness of the product when
compared with competitors (Tables 2 and 3).

• Enhancements to the market. The model can be equipped with an instrumented module
that can emulate the effects of intracranial pressure on the arachnoid. Moreover, it pro-
vides direct feedback to the surgeon, who can measure her/his skill or learning curve.

7. Conclusions
This work describes the full procedure developed to fabricate a modular model for ETA

surgery training. The procedure starts with the patient’s CT data, which was converted into
an STL model and edited with the open-source software Meshmixer v3.5.474. In particular,
the anatomy of the skull base, nasal cavity, and patient’s face was designed. Then, their
components were fabricated using additive manufacturing technology. In particular, FFF
3D printing and rapid casting processes were involved. Once assembled, the model was
tested by neurosurgeons, which provided a preliminary validation of the model. Moreover,
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the cost and time assessments demonstrated the consistency of the product as a competitor
in the market.

During the development of the model, a general procedure to design the parts of the
model and their additive manufacturing or rapid casting processes was outlined. Aspects
such as the materials suitable to replicate the behavior of bone, cartilage, and mucosa were
investigated. Moreover, the working procedure of a silicone-cast part with an embedded
insert and passing-through cavities was provided.

Overall, the model received positive feedback for anatomical fidelity and material
behavior. Moreover, suggestions for the improvement of the model were provided. In
particular, a reduction in wall thickness in some areas (skull base and nasal septum) and
the reduction in silicone spring-back (turbinates) were suggested. Moreover, the use of a
more drillable material to replace the TPU would be preferable.

The next prototypes of the model will focus on the suggested aspects. The introduction
of other anatomical details that can raise the training complexity (such as the presence of
optic nerves or the carotid artery) will be considered. Moreover, a bleeding system will be
introduced to provide a more vivid and realistic experience.
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